Tivoli Enterprise Data Warehouse
Release Notes

Version 1 Release 1
Preface

This document provides important information about Tivoli Enterprise™ Data Warehouse, Version 1 Release 1. This information is the most current information for the product and takes precedence over all other documentation. Read the information in this document before installing or using Tivoli Enterprise Data Warehouse. See Chapter 1, “About this release” on page 1 for a description of the Tivoli Enterprise Data Warehouse.

Contacting customer support

If you have a problem with any Tivoli® product, you can contact Tivoli Customer Support. See the Tivoli Customer Support Handbook at the following Web site:

http://www.tivoli.com/support/handbook/

The handbook provides information about how to contact Tivoli Customer Support, depending on the severity of your problem. It also includes information about:

- Registration and eligibility
- Telephone numbers and e-mail addresses, depending on the country you are in
- Information you should gather before contacting support

Conventions used in this book

The following typeface conventions are used in this book:

**Bold** Lowercase and mixed-case commands, command options, and flags that appear within text appear like this, in bold type.

Graphical user interface elements (except for titles of windows and dialogs) and names of keys also appear like this, in **bold** type.

*Italic* Variables, values you must provide, new terms, and words and phrases that are emphasized appear like this, in *italic* type.

**Monospace** Code examples, output, and message text appear like this, in monospace type.

Text strings you must type, when they appear within text, names of Java™ methods and classes, and HTML and XML tags also appear like this, in monospace type.

Operating system-dependent variables and paths

This book uses the UNIX® convention for specifying environment variables and for directory notation.

When using the Microsoft® Windows® command line, replace $variable with %variable% for environment variables and replace each forward slash (/) with a backslash (\) in directory paths.

**Note:** If you are using the bash shell on a Windows system, you can use the UNIX conventions.
Publications

This section lists publications in the Tivoli Enterprise Data Warehouse library and any other related documents.

The Tivoli Enterprise Data Warehouse library

The following documents are available in the Tivoli Enterprise Data Warehouse library:

- *Installing and Configuring Tivoli Enterprise Data Warehouse*, GC32-0744
  Describes how Tivoli Enterprise Data Warehouse fits into your enterprise, explains how to plan for its deployment, and gives installation and configuration instructions. It provides an introduction to the built-in program for creating and running reports, and contains maintenance procedures and troubleshooting information.

- *Enabling an Application for Tivoli Enterprise Data Warehouse*, GC32-0745
  Provides information about connecting an application to Tivoli Enterprise Data Warehouse. This book is for application programmers who want to use Tivoli Enterprise Data Warehouse to store and report on their application data, data warehousing experts who import Tivoli Enterprise Data Warehouse data into business intelligence applications, and customers who use their local data in the warehouse.

For information about creating and using groups to control access to data marts; creating, customizing, and running reports; and viewing and saving the output of reports, consult the online help topics in the IBM® Console. Information about getting started with the IBM Console is provided in *Installing and Configuring Tivoli Enterprise Data Warehouse*, GC32-0744.

Related publications

The Tivoli Presentation Services readme file contains important information for whoever installs Tivoli Enterprise Data Warehouse. The readme file is provided on the Tivoli Enterprise Data Warehouse product CD in the following location:

`\ps\docs\readme22_en`

The DB2® library contains important information about the database and data warehousing technology provided by DB2, DB2 Data Warehouse Center, and DB2 Warehouse Manager. Refer to the DB2 library for help in installing, configuring, administering, and troubleshooting DB2.

The following DB2 documents are relevant for people working with Tivoli Enterprise Data Warehouse:

- *IBM DB2 Universal Database for Windows Quick Beginnings*, GC09-2971
  Guides you through the planning, installation, migration (if necessary), and setup of a partitioned database system using the DB2 product on Windows.

- *IBM DB2 Universal Database for UNIX Quick Beginnings*, GC09-2970
  Guides you through the planning, installation, migration (if necessary), and setup of a partitioned database system using the DB2 product on UNIX.

- *IBM DB2 Universal Database Administration Guide: Implementation*, SC09-2946
  Covers the details of implementing your database design. Topics include creating and altering a database, database security, database recovery, and administering the DB2 product using the Control Center, a DB2 graphical user interface.
• **IBM DB2 Universal Database Data Warehouse Center Administration Guide, SC26-9993**
  Provides information on how to build and maintain a data warehouse using the Data Warehouse Center.

• **IBM DB2 Warehouse Manager Installation Guide, GC26-9998**
  Provides the information that you need to install the following Warehouse Manager components: Information Catalog Manager, warehouse agents, and warehouse transformers.

• **IBM DB2 Universal Database and DB2 Connect Installation and Configuration Supplement, GC09-2957**
  Provides advanced installation considerations and guides you through the planning, installation, migration (if necessary), and set up of a platform-specific DB2 client. Once the DB2 client is installed, you then configure communications for both the client and server, using the DB2 GUI tools or the Command Line Processor. This supplement also contains information on binding, setting up communications on the server, the DB2 GUI tools, DRDA® AS, distributed installation, the configuration of distributed requests, and accessing heterogeneous data sources.

• **IBM DB2 Universal Database Message Reference Volume 1, GC09-2978 and IBM DB2 Universal Database Message Reference Volume 2, GC09-2979**
  Lists the messages and codes issued by the DB2 product, the Information Catalog Manager, and the Data Warehouse Center, and describes the actions you should take.

• **IBM DB2 Universal Database Business Intelligence Tutorial**
  Provides an end-to-end tutorial for typical business intelligence tasks. It teaches you how to use the DB2 Control Center and Data Warehouse Center to create a warehouse database, move and transform source data, and write the data to the warehouse target database. It also teaches you how to use the OLAP Starter Kit to perform multidimensional analysis on relational data using Online Analytical Processing (OLAP) techniques.
Chapter 1. About this release

Tivoli Enterprise Data Warehouse enables you to access the underlying data about your network devices and connections, desktops, applications and software, events, and activities in managing your infrastructure. Having all this information in a data warehouse enables you to look at your IT costs, performance, and other trends across your enterprise. Tivoli Enterprise Data Warehouse can be used to show the value and payback of Tivoli and IBM software, and it can be used to identify areas where you can be more effective. See Installing and Configuring Tivoli Enterprise Data Warehouse for more information.

A warehouse enablement pack, or warehouse pack, is an application that interfaces with Tivoli software and Tivoli Enterprise Data Warehouse to do any of the following:

- Extract data from operational data stores and place it in the central data warehouse
- Extract data from the central data warehouse and place it in a data mart, a subset of the historical data that satisfies the needs of a specific department, team, or customer
- Provide reports of analyzed data in the data marts

The capabilities of Tivoli Enterprise Data Warehouse

Tivoli Enterprise Data Warehouse provides the following:

- An open architecture for storing, aggregating, and correlating historical data. In addition to the analysis of data collected by diverse IBM and Tivoli software, Tivoli Enterprise Data Warehouse has the flexibility and extensibility to enable you to integrate your own application data.
- Database optimizations for both the efficient storage of large amounts of historical data and for fast access to data for analysis and report generation.
- The infrastructure and tools necessary for maintaining and viewing the data. These include the Tivoli Enterprise Data Warehouse application, IBM DB2 Universal Database™ Enterprise Edition, Data Warehouse Center, DB2 Warehouse Manager, and a user interface for creating and viewing reports.
- The ability to use your choice of data analysis tools to examine your historical data. In addition to the built-in report interface, you can analyze your data using other products such as online analytical processing (OLAP), planning, trending, analysis, accounting, and data mining tools.
- The ability to control access to your historical data. You can keep data about multiple customers and data centers in one central data warehouse, but restrict access so that customers can see and work with data and reports based only on their data and not any other customer’s data. You can also restrict an individual user’s ability to access data.
- A zero-footprint client. Users can access Tivoli Enterprise Data Warehouse reports from any system by using a Web browser. No special software is required on the user’s system.
• Internationalization support. Not only is the report interface localized, application programmers can localize the data stored in the central data warehouse.
Chapter 2. Installation information

This chapter provides the following information:

- Hardware requirements
- Software requirements (see “Software requirements” on page 4)
- Database information (see “Database requirements” on page 5)
- Web browser information (see “Web browser requirements” on page 6)
- Installation notes (see “Installation notes” on page 11)

Note: If your systems do not meet the hardware and software requirements listed in this section, you will have problems installing and using the Tivoli Enterprise Data Warehouse.

Hardware requirements

This section provides information about the hardware requirements for installing Tivoli Enterprise Data Warehouse.

As the warehouse enablement pack for each Tivoli software product is added to the Tivoli Enterprise Data Warehouse installation, additional hard disk space is required. See the documentation for each warehouse pack for application planning information and hard disk space requirements.

Table 1 on page 4 lists the minimum and recommended hardware requirements for the Tivoli Enterprise Data Warehouse.
### Table 1. Hardware requirements

<table>
<thead>
<tr>
<th>Installation configuration</th>
<th>Component</th>
<th>Minimum requirements</th>
<th>Recommended size</th>
<th>Temporary hard disk space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stand-alone</td>
<td>All</td>
<td>• 512 MB RAM</td>
<td>• 1 GB RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 GB hard disk space</td>
<td>• 3 GB hard disk space</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 933 MHz processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distributed</td>
<td>Control server</td>
<td>• 512 MB RAM</td>
<td>• 1 GB RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 800 MB hard disk space</td>
<td>• 1 GB hard disk space</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 933 MHz processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Report server</td>
<td>• 512 MB RAM</td>
<td>• 1 GB RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 800 MB hard disk space</td>
<td>• 1.5 GB hard disk space</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 933 MHz processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Central data</td>
<td>• 512 MB RAM</td>
<td>• 1 GB RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td></td>
<td>warehouse</td>
<td>• 1 GB hard disk space</td>
<td>• 20 GB hard disk space</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 933 MHz processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data mart</td>
<td>• 512 MB RAM</td>
<td>• 1 GB RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 GB hard disk space</td>
<td>• 3 GB hard disk space</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 933 MHz processor</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 If you plan to install other Tivoli software products that use the IBM Console, you must install those applications on the same system where you install the report interface. Therefore, ensure that the computer where you are installing the report interface has the sufficient hard disk space, memory, and processor speed for those applications. See the documentation for each product for more information about their requirements.

### Software requirements

This section provides information about the software requirements for the Tivoli Enterprise Data Warehouse.

**Note:** You might receive confusing error messages if your systems do not meet the software requirements listed in this section.

The following table lists the operating systems supported by the Tivoli Enterprise Data Warehouse.

### Table 2. Supported operating systems

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Data source 1</th>
<th>Warehouse agents</th>
<th>Control server</th>
<th>Central data warehouse</th>
<th>Data mart database</th>
<th>Report server 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows NT® Service pack 6 or higher, Windows 2000 Server, Windows 2000 Advanced Server</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IBM AIX® versions 4.3.3 and 5.1</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sun Solaris versions 2.7 and 2.8</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RedHat Linux Version 7.1</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>SuSE Linux Version 7.2</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 2. Supported operating systems (continued)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Data source ¹</th>
<th>Warehouse agents</th>
<th>Control server</th>
<th>Central data warehouse</th>
<th>Data mart database</th>
<th>Report server ²</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹ Data source support is determined by ODBC support in DB2 releases.

² See “Report interface requirements” on page 7 for more information about the operating system requirements for the report server.

Database requirements

This section provides information about your database installation.

Tivoli Enterprise Data Warehouse requires DB2 Version 7 Release 2 with FixPak 5. If you are currently running a DB2 version prior to 7.2, you must upgrade to version 7.2 with FixPak 5 using the DB2 CDs provided with Tivoli Enterprise Data Warehouse. On the control server, you must additionally apply the emergency fixes (e-fixes) for APARs JR16650 and JR16766. If you are an application developer creating a warehouse pack, you must also apply these APARs on the system from which you export the tag files for your application.

The e-fixes are available on the following Tivoli Enterprise Data Warehouse support Web site:


The recommended hard disk space in Table 1 on page 4 is large enough to accommodate some data growth as transactions are added to the database. However, when you plan for your database requirements, you must consider the following:

- Future data growth
- Addition of warehouse packs
- Customizing reports
- Saving report output

It is recommended that you install your central data warehouse on an expandable system with a minimum of 20 GB of data space. Refer to the DB2 library for database recommendations.

Table 3 lists the databases that are supported by the Tivoli Enterprise Data Warehouse components.

Table 3. Supported databases

<table>
<thead>
<tr>
<th>Relational database management system</th>
<th>Data sources¹</th>
<th>Control database</th>
<th>Central data warehouse</th>
<th>Data marts</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 V 7.2, FixPak 5</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DB2 V6</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Oracle V8.1.7 on Windows NT, Windows 2000, AIX, and Solaris</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Table 3. Supported databases (continued)

<table>
<thead>
<tr>
<th>Relational database management system</th>
<th>Data sources[1]</th>
<th>Control database</th>
<th>Central data warehouse</th>
<th>Data marts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server V7.0 on Windows NT</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Microsoft SQL Server V2000 on Windows 2000</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Sybase V11.5 on Windows NT</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Sybase V11.9.2 on AIX</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Informix™ V7.2.2 – V9.0 on Windows NT</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Informix V7.2.4 – V9.2.0 on AIX</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

\[1\] Data source support is determined by ODBC support in DB2 releases.

Table 4 lists the DB2 requirements for each Tivoli Enterprise Data Warehouse component.

Table 4. DB2 requirements

<table>
<thead>
<tr>
<th>Installation configuration</th>
<th>Component</th>
<th>DB2 requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stand-alone</td>
<td>All</td>
<td>DB2 Server</td>
</tr>
<tr>
<td>Distributed</td>
<td>Control server</td>
<td>DB2 Server</td>
</tr>
<tr>
<td></td>
<td>Central data warehouse</td>
<td>DB2 Server</td>
</tr>
<tr>
<td></td>
<td>Data mart</td>
<td>DB2 Server</td>
</tr>
<tr>
<td></td>
<td>Report server</td>
<td>DB2 Client</td>
</tr>
</tbody>
</table>

Web browser requirements

This section describes the Web browser requirements for the Tivoli Enterprise Data Warehouse.

Note that JavaScript™ and style sheets must be enabled in these browsers.

You can configure Tivoli Presentation Services to use the Secure Sockets Layer (SSL). Note that this requires 128 bit support.

Table 5 lists the Web browsers that are supported for use with Tivoli Enterprise Data Warehouse. Each user is responsible for installing the correct version of the browser on their workstation. The Tivoli Enterprise Data Warehouse installation program does not install the Web browser.

Table 5. Supported Web browser information

<table>
<thead>
<tr>
<th>Browser</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer</td>
<td>5.5 and 6.0</td>
</tr>
<tr>
<td>Netscape Navigator</td>
<td>4.62 and 4.71</td>
</tr>
</tbody>
</table>
Report interface requirements

The report interface uses the IBM console, which is implemented using Tivoli Presentation Services. The following operating systems are supported:

- Windows systems:
  - Windows NT 4.0 Server with Service Pack 6
  - Windows 2000 Server
  - Windows 2000 Advanced Server

The Java version of the IBM Console can also run on Windows 2000 Professional, but the Server and Web Services for the IBM Console cannot.

- UNIX-based systems:
  - AIX 4.3.3.10 and 5.1 with the required operating system patches for Java Runtime Environment 1.3. See “AIX system requirements” for more information.
  - Red Hat Linux 7.1
  - Solaris 7 and 8 with the required operating system patches for Java Runtime Environment 1.3. See “Solaris system requirements” on page 10 for more information.
  - SuSE Linux 7.1
  - UNIX-based GUIs for X-Window environment:
    - For AIX and Solaris systems, the Common Desktop Environment (CDE)
    - For Red Hat Linux and SuSE Linux systems, the K Desktop Environment (KDE) and the GNU Network Object Model Environment (GNOME)

AIX system requirements

Tivoli Presentation Services includes the IBM AIX Java Runtime Environment, Version 1.3. This JRE requires AIX 4.3.3.10 or AIX 5.1.

For AIX 4.3.3, this means that you need the 4330-02 (or later, 4330-03 for example) Recommended Maintenance package. You can order the 4330-02 package (or download required file sets from the FixDist Web site) with Authorized Program Analysis Report (APAR) IY06844. You can also obtain it on the 2/2000 Update CD that is shipped with the AIX product. In the United States, you can call IBM at 800-879-2755 and request a refresh of the AIX 4.3.3 media.

For AIX 5.1, no APARs or maintenance packages are required.

To check the current level of bos.rte.libc, use the following command:

```
lslpp -ah bos.rte.libc
```

File sets and APARs for all locales: The Java Runtime Environment that is included with Tivoli Presentation Services requires the following AIX base-level file sets for all locales:

- X11.adt.lib 4.3.3.0
- X11.adt.motif 4.3.3.0
- bos.adt.include 4.3.3.0
- bos.adt.prof 4.3.3.0

If these file sets are not already installed, you can find them on the AIX 4.3.3 GA installation media.
In addition, required APARs and associated program temporary fixes (PTFs) must be applied to your AIX system for all locales, with the preceding base-level file sets already installed. These required APARs are listed in Table 6 and Table 7. Depending on whether your system is uniprocessor or multiprocessor, you must apply one of the APARs listed in Table 7.

Optional APARs are listed in Table 8.

These APARs are not available on the AIX 4.3.3.10 GA installation media, but can be obtained from IBM if they are not already on your AIX system. The recommended upgrade mechanism is to use the FixDist tool, which is available at the following Web site:

http://techsupport.services.ibm.com/server/support

Table 6. Required APARs for all locales

<table>
<thead>
<tr>
<th>PTF Number</th>
<th>APAR Number</th>
<th>File set</th>
<th>VRMF</th>
</tr>
</thead>
<tbody>
<tr>
<td>U467183</td>
<td>IY03993</td>
<td>bos.adt.include</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U467290</td>
<td>IY06365</td>
<td>bos.net.tcp.client</td>
<td>4.3.3.3</td>
</tr>
<tr>
<td>U467478</td>
<td>IY04069</td>
<td>bos.sysmgt.serv_aid</td>
<td>4.3.3.2</td>
</tr>
<tr>
<td>U467572</td>
<td>IY05690</td>
<td>X11.base.lib</td>
<td>4.3.3.2</td>
</tr>
<tr>
<td>U467473</td>
<td>IY05697</td>
<td>X11.adt.motif</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U467558</td>
<td>IY05741</td>
<td>X11.base.rte</td>
<td>4.3.3.2</td>
</tr>
<tr>
<td>U467459</td>
<td>IY05989</td>
<td>X11.Dt.rte</td>
<td>4.3.3.3</td>
</tr>
<tr>
<td>U467557</td>
<td>IY05989</td>
<td>X11.motif.mwm</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U467458</td>
<td>IY05990</td>
<td>X11.motif.lib</td>
<td>4.3.3.2</td>
</tr>
<tr>
<td>U467616</td>
<td>IY05990</td>
<td>X11.compat.lib.X11R5</td>
<td>4.3.3.2</td>
</tr>
<tr>
<td>U467283</td>
<td>IY06171</td>
<td>bos.rte.libpthreads</td>
<td>4.3.3.3</td>
</tr>
<tr>
<td>U467444</td>
<td>IY06171</td>
<td>bos.adt.prof</td>
<td>4.3.3.3</td>
</tr>
<tr>
<td>U467222</td>
<td>IY06121</td>
<td>X11.Dt.lib</td>
<td>4.3.3.2</td>
</tr>
<tr>
<td>U470006</td>
<td>IY05851</td>
<td>bos.rte.net</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U470966</td>
<td>IY10887</td>
<td>bos.rte.libc</td>
<td>4.3.3.15</td>
</tr>
<tr>
<td>U471143</td>
<td>IY09937</td>
<td>bos.net.tcp.client</td>
<td>4.3.3.15</td>
</tr>
<tr>
<td>U470973</td>
<td>IY10368</td>
<td>X11.base.rte</td>
<td>4.3.3.14</td>
</tr>
<tr>
<td>U470980</td>
<td>IY10134</td>
<td>X11.motif.lib</td>
<td>4.3.3.15</td>
</tr>
<tr>
<td>U471092</td>
<td>IY10707</td>
<td>X11.base.lib</td>
<td>4.3.3.15</td>
</tr>
</tbody>
</table>

Table 7. Processor–dependent required APARs for all locales

<table>
<thead>
<tr>
<th>PTF Number</th>
<th>APAR Number</th>
<th>File set</th>
<th>VRMF</th>
</tr>
</thead>
<tbody>
<tr>
<td>U467275</td>
<td>IY06625</td>
<td>bos.up (uniprocessor)</td>
<td>4.3.3.3</td>
</tr>
<tr>
<td>U467531</td>
<td>IY06625</td>
<td>bos.mp (multiprocessor)</td>
<td>4.3.3.3</td>
</tr>
</tbody>
</table>

Table 8. Optional APARs for all locales

<table>
<thead>
<tr>
<th>PTF Number</th>
<th>APAR Number</th>
<th>File set</th>
<th>VRMF</th>
</tr>
</thead>
<tbody>
<tr>
<td>U471872</td>
<td>IY11114</td>
<td>jkit.Wnn6.base</td>
<td>2.1.1.5</td>
</tr>
<tr>
<td>U471060</td>
<td>IY10887</td>
<td>bos.adt.prof</td>
<td>4.3.3.15</td>
</tr>
</tbody>
</table>
Table 8. Optional APARs for all locales (continued)

<table>
<thead>
<tr>
<th>PTF Number</th>
<th>APAR Number</th>
<th>File set</th>
<th>VRMF</th>
</tr>
</thead>
<tbody>
<tr>
<td>U466991</td>
<td>IY10613</td>
<td>bos.loc.com.JP</td>
<td>4.3.3.11</td>
</tr>
<tr>
<td>U471076</td>
<td>IY10801</td>
<td>bos.loc.utf.ZH_TW</td>
<td>4.3.3.11</td>
</tr>
<tr>
<td>U471118</td>
<td>IY10368</td>
<td>X11.fnt.fontServer</td>
<td>4.3.3.12</td>
</tr>
<tr>
<td>U471015</td>
<td>IY10368</td>
<td>X11.fnt.ucs.ttf_CN</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U471838</td>
<td>IY10782</td>
<td>devices.isa_sio.baud.rte</td>
<td>4.3.2.1</td>
</tr>
</tbody>
</table>

Note: If double-byte Japanese characters are to be displayed in an AIX 4.3.3 environment, you must use the following:
- DB2 7.2 with FixPak 5
- IBM-euc Japanese (EUC) as the primary language
- UTF-8 Japanese (JA_JP)

File sets and APARs for specific locales or DBCS locales: The Java Runtime Environment that is included with Tivoli Presentation Services requires the following AIX base-level file sets for specific locales or double byte character set (DBCS) locales:
- bos.loc.com.utf 4.3.3.0
- bos.iconv.Vi_VN 4.3.0.0
- bos.loc.iso.zh_TW 4.3.3.0

If these file sets are not already installed, you can find them on the AIX 4.3.3 GA installation media. The packages that contain these file sets are bos.loc.com.usr.4.3.3.0 and bos.inconv.usr.4.3.3.0.

In addition, the APARs listed in Table 9 must be applied to your AIX system for specific locales or DBCS locales, with the preceding base-level file sets already installed.

These APARs are not available on the AIX 4.3.3.10 GA installation media, but can be obtained from IBM if they are not already on your AIX system. The recommended upgrade mechanism is to use the FixDist tool, which is available at the following Web site:

http://techsupport.services.ibm.com/server/support

Table 9. Required APARs for Specific Locales or DBCS Locales

<table>
<thead>
<tr>
<th>PTF Number</th>
<th>APAR number</th>
<th>File set</th>
<th>VRMF</th>
</tr>
</thead>
<tbody>
<tr>
<td>U469092</td>
<td>IY06121</td>
<td>bos.loc.iso.th_TH</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U469091</td>
<td>IY06121</td>
<td>bos.loc.iso.Vi_VN</td>
<td>4.3.3.1</td>
</tr>
<tr>
<td>U467545</td>
<td>IY05472</td>
<td>bos.loc.iso.zh_TW</td>
<td>4.3.3.1</td>
</tr>
</tbody>
</table>

If you are using one of the supported non-UTF8 CKJ locales, one of the following file sets (available from the AIX 4.3.3 or 5.1 base CDs) is required:
- X11.fnt.ucs.ttf (for ja_JP or Ja_JP)
- X11.fnt.ucs.ttf_CN (for zh_CN or Zh_CN)
- X11.fnt.ucs.ttf_KR (for ko_KR)
- X11.fnt.ucs.ttf_TW (for zh_TW or Zh_TW)
Solaris system requirements
Tivoli Presentation Services includes the Java 2 Platform, Standard Edition (J2SE), Java Runtime Environment (JRE). This JRE runs on Solaris 7 or 8 with the required and recommended patches listed in Table 10 and Table 11.

To determine which patches are already installed on your system, use the following shell command:

```
showrev -p
```

In addition to verifying that your system includes the correct patches, you might want to install the latest patch cluster for your version of the Solaris system. Patch clusters include additional recommended and security patches.

You can obtain the patches and patch clusters from your service provider, or you can download them individually from the SunSolve Web site at:

http://sunsolve.sun.com

Use the search function on the SunSolve site to search for the patch number.

The J2SE download site includes download tar bundles that contain the patches and includes the latest information about recommended and required patches for the JRE. For more information, refer to the following Web site:

http://java.sun.com/j2se/1.3/install-solaris-patches.html

In the following tables, the two-digit number following the hyphen in each patch ID is the revision number for that patch. Although the tables list the revisions with which this release of J2SE was tested, later patch revisions should work also.

Table 10. Patches for Solaris 8

<table>
<thead>
<tr>
<th>Solaris-SPARC patch ID</th>
<th>Description</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>108940-12 or later</td>
<td>Motif 2.1 patch</td>
<td>Yes</td>
</tr>
<tr>
<td>108921-07 or later</td>
<td>For CDE window manager</td>
<td>Recommended for CDE users</td>
</tr>
</tbody>
</table>

Table 11. Patches for Solaris 7

<table>
<thead>
<tr>
<th>Solaris-SPARC patch ID</th>
<th>Description</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>107226-12 or later</td>
<td>For CDE window manager</td>
<td>Recommended for CDE users</td>
</tr>
<tr>
<td>106980-12 or later</td>
<td>Libthreads patch</td>
<td>Yes</td>
</tr>
<tr>
<td>107153-01 or later</td>
<td>Required for zh.GBK Chinese locale</td>
<td>Recommended</td>
</tr>
<tr>
<td>107636-06 or later</td>
<td>Implementation of composition enabling/disabling API for X input methods</td>
<td>Recommended</td>
</tr>
<tr>
<td>107544-03 or later</td>
<td>SunOS 2.7 Kernel update</td>
<td>Yes</td>
</tr>
<tr>
<td>106541-12 or later</td>
<td>SunOS 2.7 Kernel update</td>
<td>Yes</td>
</tr>
<tr>
<td>109104-04 or later</td>
<td>SunOS 2.7 Kernel update</td>
<td>Yes</td>
</tr>
<tr>
<td>108376-16 or later</td>
<td>OpenWindows 3.6.1 Xsun patch. <strong>Note</strong>: Some later versions of this patch, including 108377-10, cause an X server crash.</td>
<td>Yes</td>
</tr>
<tr>
<td>Solaris-SPARC patch ID</td>
<td>Description</td>
<td>Required?</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
<td>-----------</td>
</tr>
<tr>
<td>106950-13 or later</td>
<td>Linker patch</td>
<td>Yes</td>
</tr>
<tr>
<td>107081-25 or later</td>
<td>Motif 1.2, Motif 2.1, and runtime library patch.</td>
<td>Yes</td>
</tr>
<tr>
<td>106300-09 or later; and 106327-08 or later</td>
<td>Shared library patch for C++</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Installation notes

This section provides information about the Tivoli Enterprise Data Warehouse installation. Review the information in this section before you begin your installation. See *Installing and Configuring Tivoli Enterprise Data Warehouse* for more information about the topics described in this section.

- Installation of Tivoli Enterprise Data Warehouse might fail with the following message in the TWH.log file:
  ```
  ==> Testing DB2 exec path  
  (F) CDWIC0024E Could not execute/locate DB2 command!!! 
  ```
  This is because the PATH environment variable has become too long. The PATH environment variable is limited to 2075 characters in length.

  Workaround: Use the workaround provided in step 1 first. If the problem persists, use the workaround provided in step 2.

  1. During installation, specify a short temporary directory. For example, by default, Microsoft Windows 2000 sets the TEMP variable to `C:\Documents and Settings\db2admin\Local Settings\Temp`. Instead, specify `C:\temp`.

  2. Before you start to install Tivoli Enterprise Data Warehouse, temporarily shorten the PATH environment variable. During the installation, the PATH variable is appended to the end of the PATH that is created.

- During a distributed installation on AIX and Linux, when the feature selection window of the Tivoli Enterprise Data Warehouse installation wizard is displayed, you must wait for the screen to display and then redisplay before making any selections. If you do not wait, your selections are discarded.

- If you are performing a silent installation of Tivoli Enterprise Data Warehouse on a UNIX system without a local X11 server, you must set and export the DISPLAY environment variable to a valid X11 server. The X11 server can be on a different system.

- A distributed installation means that you have installed Tivoli Enterprise Data Warehouse on more than one system. For a distributed installation, the domain name service (DNS) must be able to resolve host names from short names.

- You must specify unused port numbers when you install Tivoli Enterprise Data Warehouse. Specifying port numbers that are already in use by other programs can cause the installation to lock up. In particular, if there is already a Web server on the system that you plan to install the report server on, you must uninstall it, disable it, or specify a different port number for the HTTP Server Port for Tivoli Presentation Services.
Chapter 3. Software limitations, problems, and workarounds

This section provides information about known software limitations and defects for Tivoli Enterprise Data Warehouse, Version 1 Release 1.

Software problems are known defects with the Tivoli Enterprise Data Warehouse. Workarounds are provided for some problems. Defects listed in “Software problems and workarounds” on page 14 apply to all languages. For information about defects associated with specific languages, see Chapter 5, “Internationalization notes” on page 25.

Software limitations

This section describes the limitations of the Tivoli Enterprise Data Warehouse product.

Report interface limitations

- Displaying the metric information for reports containing data from multiple customers can take several minutes.
- A browser window refresh initiated by the superadmin or a user with SecAdminRole authority results in a refresh of all other browser windows of users viewing the same information in the Manage User Groups and Manage Data Marts portfolio tasks.
- If a report is run by more than one user simultaneously, there is no guarantee that the report output will have unique names. The report output is not saved in the database.
- If a transaction is started and cannot be completed, an error message might be displayed. For example, if one user deletes a report while a second user is working with the report, the user working with the report receives an error message when attempting to complete a task involving the report.
- A report name that already exists cannot be used to name another report, even though a user might not have access to all existing reports.
- Ownership of a report cannot be changed. The owner of a report is the user ID of the report creator.

Miscellaneous limitations

- If Information Catalog Manager (ICM) Version 7 is installed on the same Windows NT or Windows 2000 system as Sybase Open Client, an error occurs and the Sybase Utilities stops. An error message similar to the following is displayed:
  Fail to initialize LIBTCL.DLL.
  Please make sure the SYBASE environment variable is set correctly.

Remove the LC_ALL environment parameter from the Windows environment parameters to correct this problem. Note that if you remove the LC_ALL environment, the following ICM functions are disabled:

- Information Catalog User
- Information Catalog Administrator
- Information Catalog Manager
LC_ALL is a locale category parameter. Locale categories are manifest constants used by the localization routines to specify which portion of the locale information a program should use. The locale refers to the locality (country or region) for which certain aspects of a program can be customized. Locale-dependent areas include, for example, the formatting of dates, or the display format for monetary values. LC_ALL affects all categories of locale-specific behavior.

Use the following procedure to remove the LC_ALL environment parameter:
1. On the task bar, select the Start button → Settings → Control Panel → System. The System Properties window is displayed.
2. Select the Environment tab.
3. Select LC_ALL.
4. Click Delete.
   • When using Sybase, the following error message might be displayed:
     The 'CREATE TABLE' command is not allowed within a multi-statement transaction in the 'database_name' database

Use the following procedure as a workaround:
1. From the ISQL command line, enter use master.
2. Enter go.
3. Enter sp_dboption dbname,"ddl in tran",true, where dbname is the name of the database.
4. Enter go. The following message is displayed:
   Database option 'ddl in tran' turned ON for database 'dbname'
   Run the CHECKPOINT command in the database that was changed.
   (return status = 0)
5. Enter use dbname.
6. Enter go.
7. Enter checkpoint.
8. Enter go.
9. Enter quit.

Software problems and workarounds

This section provides information about known problems (defects) with the English language version of the Tivoli Enterprise Data Warehouse, Version 1 Release 1. See Chapter 5, “Internationalization notes” on page 25 for information about defects found only in other language versions of the Tivoli Enterprise Data Warehouse.

The following information is provided:
• Defect number and brief problem abstract
• Problem description
• Workaround (if available)

Defects

Defect information in this section is categorized as follows:
• Installation or uninstallation
• Report interface
• Miscellaneous
Installation or uninstallation defects

- Defect 127998: The amount of required hard disk space that is displayed is incorrect.
  
  During installation, the value for Total MB that is displayed in the Summary window of the installation wizard is incorrect.
  
  Workaround: See Table 1 on page 4 for the amount of required hard disk space.

- Defect 128144: The Tivoli Presentation Services installation locks up if a port number is specified that is already in use.

  Workaround for defect 128144: When you install Tivoli Presentation Services, ensure that you use unique port numbers that are not used by any other components. See Installing and Configuring Tivoli Enterprise Data Warehouse for a list of port numbers that are used by Tivoli Presentation Services.

- Defect 131101:
  
  You must modify the security file to enable the report server to run on UNIX.
  
  Modify the security file `ps_install_dir/psjvm/jre/lib/security/java.security` as follows:
  
  1. Edit file `ps_install_dir/psjvm/jre/lib/security/java.security`, where `ps_install_dir` is the name of the directory in which the IBM console is installed.
  
  2. Add the following statement:

     `security.provider.2=com.ibm.crypto.provider.IBMJCE`

  
  Note: `IBMJCE` must be the second security provider. If a `security.provider.2` is already defined, change that one to `security.provider.3`, and then add the statement in step 2.

- Defect 131139: User is prompted to overwrite or update the Java Virtual Machine (JVM).
  
  When starting the Tivoli Enterprise Data Warehouse installer after an initial installation, you might be prompted to update or overwrite the JVM.
  
  Workaround: Select Yes to continue the installation.

- Defects 131371 and 133515: Text is truncated in some installation windows.
  
  Text in some windows of the installation wizard is truncated or wraps incorrectly. This happens most frequently on UNIX systems.
  
  Workaround: Resize the window until all of the text is displayed. If this does not resolve the problem, change your screen resolution.

- Defect 131711: Temporary installation directories are not removed.
  
  The temporary installation directory, `tmptedw_1_1_install` is not deleted when the installation process is completed. Files in this directory are overwritten during a subsequent installation.
  
  Workaround: Manually delete the temporary installation directory, `tmptedw_1_1_install` after you have successfully installed Tivoli Enterprise Data Warehouse. See Installing and Configuring Tivoli Enterprise Data Warehouse for more information.

- Defect 131929: A DB2 user ID and password is required to use the --listapps option of the Tivoli Enterprise Data Warehouse warehouse pack uninstallation program.

  Workaround: Use the following procedure to obtain a list of warehouse packs installed with Tivoli Enterprise Data Warehouse:
  
  - Edit the uninstall configuration file `thw_app_deinstall.cfg`
  - Add the DB2 user IDs and passwords
- Run the following command on the control server:

```
$TWH_TOPDIR/install/bin/twh_app_deinstall.sh -c "twh_app_deinstall.cfg" \\
--listapps
```

See *Installing and Configuring Tivoli Enterprise Data Warehouse* for more information.

- Defect 132024: A message similar to the following is generated during the installation:

```
Setup has detected that you have version X of DB2 installed and the product you
are installing requires version Y
```

Workaround: Complete the following steps, even if versions X and Y in the message are very similar:

1. Cancel the Tivoli Enterprise Data Warehouse installation.
2. Update or change the DB2 installation on the target system to that specified in "Database requirements" on page 5. If the message specifies a lower release level than these release notes, ignore the release level in the message. If the component you are installing requires DB2 Server (as documented in the *Installing and Configuring Tivoli Enterprise Data Warehouse*), ensure that the server component is installed and not a DB2 client.
3. Restart the Tivoli Enterprise Data Warehouse installation.

- Defects 132469 and 133518: When installing Tivoli Enterprise Data Warehouse components on AIX, you might receive one of the following error messages:
  - PS Server is stopped but never restarted.
  - File system expansion hit duplicate partition name. Resuming.

Workaround: See the Troubleshooting chapter in *Installing and Configuring Tivoli Enterprise Data Warehouse* for restarting the Tivoli Presentation Services servers.

- File system expansion hit duplicate partition name. Continue.

Workaround: Ignore this error message. The installation is not affected.

- Defect: 133572: During a distributed installation of the control server, the progress indicator is incorrect.

When the control server is being installed, the percent complete indicator bar remains at 0 percent until the installation is 96 percent complete. This problem occurs when installing only the control server component.

Workaround: Ignore the percent complete indicator bar, because the installation of the control server is proceeding normally.

- Defect 133820: The Tivoli Enterprise Data Warehouse installation fails if you create your own DB2 instance, but you do not create a database in that instance.

Workaround: Use the following procedure to create a database in the new instance.

- Log on as a DB2 administrator.
- Enter the following:

```
db2 create database database_name
```

Where *database_name* is the name of the database.
- Continue the Tivoli Enterprise Data Warehouse installation.

- Defect 133863: The Task Assistant of the IBM Console does not display help.

This can be caused by the system being rebooted before the help set build completes.
Workaround: Do not reboot the system until the help set is rebuilt. If you do, the help is not rebuilt. Use the following procedure to rebuild the help:

– For Windows, enter the following command:

```
PS_directory\bin\w32-i386\rebuildHelp.bat
```

For UNIX, enter the following command:

```
PS_directory/bin/generic_unix/rebuildhelp.sh
```

where `PS_directory` is the directory where Tivoli Presentation Services is installed.

– Wait up to 60 minutes for the help to rebuild.

To determine whether the help set rebuild is complete, look for the completion message in the Tivoli Presentation Services installation log. This log is in directory `PS_directory/log/fwp_mcr`, where `PS_directory` is the target directory you specified for Tivoli Presentation Services. The logs are named `stdoutn`, where `n` is a number that increments each time Tivoli Presentation Services is started. Look for the following message in the most recent `stdoutn` file. In some cases, the message can be in the second most recent `stdoutn` file.

```
FWP1734I The utility that was started by the Management Component Repository to build the help set has completed successfully.
```

• Defect 134074: Warehouse pack installation fails to load data into the translated term table.

During a warehouse pack installation in a distributed configuration, if the control server database and the central data warehouse database have different user names and passwords, the NLS bundles that supply the translated values into the translated term table within the central data warehouse database are not loaded. This causes the report interface using this table to default to English instead of the localized language for some reporting measurements. The installation does not stop for this error and a false indication of a successful installation is displayed.

Workaround: Before you perform a distributed installation, ensure that the same user name and password is specified for both the control server and central data warehouse components. Because the DB2 administrators might be different for the databases, add an administrator to either the control server or the central data warehouse database that matches the other database, as follows.

– On Microsoft Windows, add a user and add the new user to the Local Administrators Group.

– On UNIX, add a user and add the new user to the group that is the primary group of the DB2 instance owner.

• Defect 134100: The warehouse pack uninstallation fails when table names are longer than 30 characters.

Workaround: Either drop the tables manually before running the warehouse pack uninstallation program, or drop the tables after the uninstallation fails and run the uninstallation script again. Use the following SQL statement to manually drop a table:

```
DROP TABLE name
```

Where `name` is the name of the table.

• Defect 134432.1: On Windows systems, when Tivoli Enterprise Data Warehouse and Tivoli Presentation Services are installed in different drives on the same system, the installation program puts the wrong drive letter in the PATH environment variable for the Tivoli Presentation Services files.
For example, if you install Tivoli Enterprise Data Warehouse in D:\TWH and Tivoli Presentation Services in C:\PS, the PATH environment variable contains the value D:\PS for Tivoli Presentation Services.

Workaround: Change the PATH environment variable by completing the procedure for your operating system.

– On Windows NT, complete these steps:
  1. Log on as a user in the Administrators group.
  2. From the Windows taskbar, click **Start** → **Settings** → **Control Panel**.
  3. Double-click **System**.
  4. In the System Properties window, click **Environment**.
  5. In the **System variables** list, select **PATH**.
  6. In the **Value** field, correct the drive letter in the Tivoli Presentation Services portion of the environment variable.
  7. Click **OK**.

– On Windows 2000, complete these steps:
  1. Log on as a user in the Administrators group.
  2. From the Windows taskbar, click **Start** → **Settings** → **Control Panel** → **System** → **Advanced** → **Environment Variables**.
  3. Under **System variables**, select **PATH**.
  4. Click **Edit**.
  5. Correct the drive letter in the Tivoli Presentation Services portion of the environment variable.

• Defect 134582: On AIX, if you uninstall Tivoli Presentation Services, the Server for IBM Console process is not stopped. If you intend to reinstall Tivoli Presentation Services, either by itself or as a prerequisite to installing Tivoli Enterprise Data Warehouse, you must manually stop the Server for IBM Console process before attempting the installation.

You can manually stop the Server for IBM Console process by doing the following:

1. Obtain the process ID of the Server for IBM Console process that is running by issuing the following command:
   ```bash
   ps -ef | grep Mcr
   ```

2. Issue the following command, where `mcr_process_ID` is the process ID of the Server for IBM Console process found in the previous step:
   ```bash
   kill -9 mcr_process_ID
   ```

If the Server for IBM Console process is running when you attempt to install Tivoli Presentation Services or Tivoli Enterprise Data Warehouse, the installation fails with the following symptoms:

1. During the installation of Tivoli software that uses Tivoli Presentation Services, you may receive an error indicating that the following command has failed:
   ```bash
   setAppProperty for RemoteAdapterName
   ```

2. When you attempt to stop the Server for IBM Console process using one of the following commands, you might receive a message that the subsystem is already stopped.
   ```bash
   /usr/PS/bin/generic_unix/stopmcr.sh
   ```
   - or –
   ```bash
   stopsrc -s tcserver
   ```
3. The Server for IBM Console process fails to start completely and you see error FNGOB0045E in the stderrn.log that an ORB is already running on port 8010.

4. You see either of the following errors in ps_install_directory/log/fwp_mcr/stdoutn.log:
   2002.03.12 12:10:00.429 McrClientServer run()
   com.tivoli.pf.mcr.external.McrImportFailedException: Import of package
   /usr/PS/cd/com.tivoli.pfdk.ful.util@2.2.0.jar failed.
   2002.03.12 12:10:00.440 ComponentManager getService
   com.objectspace.voyager.NamespaceException: no object bound to the name
   vdir://rigel.rtp.lab.tivoli.com:8010/FailoverAgent;

Workaround: Uninstall the parts of Tivoli Enterprise Data Warehouse and Tivoli Presentation Services on the machine where Tivoli Presentation Services is installed. Stop the Server for IBM Console process as described above. Reinstall the components of Tivoli Enterprise Data Warehouse that were on the machine.

On AIX, if the Server for IBM Console process is running and you try to stop it with the command
stopsrc -s tcserver

or

ps_install_directory/bin/generic_unix/stopmcr.sh

and you get a response that the subsystem is inoperative, then you must use the following script to stop the process:
ps_install_directory/bin/private/generic_unix/stopmcr.sh

You can check to see if the Server for IBM Console process is running using the following command:
ps -ef | grep Mcr

Avoid using the command
kill -9 process_id

because this may leave the Server for IBM Console process in an unusable state.

Similarly, the Web Services for IBM Console process may not respond to the following command:
stopsrc -s tcwebsvs

If that is the case, then use the following script to stop the process:
ps_install_directory/bin/private/generic_unix/stopwc.sh

Report interface defects
• Defect 126085: The reports context menu contains multiple entries.
  For users logged as superadmin, the portfolio and the context menus for reports and data marts contain multiple menus. For example, the context menus for reports and data marts contain two Create a Report entries, and the context menu for reports contains three entries for Properties.
  Workaround: Do not work with reports as user superadmin, or use the first entry in the list of duplicate entries which represents the highest level role authorized to perform that function.
• Defect 130465: Report interface text is unreadable after the context menu is closed.
  This is caused by Netscape’s use of the code page.
  Workaround: Change the default character set of the Netscape browser to UTF-8 as follows:
  – From the menu bar, select View.
  – Select Unicode (UTF-8). The View menu is closed.
  – From the menu bar, select View > Character Coding.

• Defect 130726: On AIX, the report interface encounters a memory constraint error.
  By default, AIX does not permit 32-bit applications to attach to more than 11 shared memory segments per process, of which a maximum of 10 can be used for local DB2 connections. When there is a local database on AIX, the report interface encounters the following memory constraint error when accessing that database, because the number of concurrent processes exceeds the allowable amount:
  COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] SQL1224N
  A database agent could not be started to service a request, or was terminated as a result of a database system shutdown or a force command. SQLSTATE=55032

  Workaround: Use EXTSHM to increase the number of shared memory segments as follows:

  When starting the DB2 server, enter the following commands:
  ```
  export EXTSHM=ON
  db2set DB2ENVLIST=EXTSHM
  db2start
  ```

• Defect 131750: Labels do not display on the y-axis of health check and extreme case report output.
  There is no workaround for defect 131750. The information is provided below the report output.

• Defect 132282: None is not a valid aggregation option for any type of report.
  There is no workaround for defect 132282.

• Defect 133678: A summary report fails to run if group by and order by choices do not match.
  When running a summary report, the following DB2 error message is displayed if the selections for group by and order by are not the same:
  COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver][DB2/NT] SQL0119N An expression starting with "CPU_SPEED" specified in a SELECT clause, HAVING clause, or ORDER BY clause is not specified in the GROUP BY clause or it is in a SELECT clause, HAVING clause, or ORDER BY clause with a column function and no GROUP BY clause is specified. SQLSTATE=42803

  Workaround: When creating a summary report, ensure that the group by and order by selections match. For example, if the user’s selection for group by is CPU_Speed = 1, then the order by selection for CPU_Speed must be either 1 ascending or 1 descending. (The ascending or descending in the order by selection is ignored.)

**Miscellaneous defects**

• Defect 127228: Extract, transform, and load (ETL) processes fail to run.
For Windows NT and Windows 2000, the vwserver and vwlogger services do not log on as the DB2 user, which causes ETL processes to fail.

Workaround: Perform the following procedure for Windows NT:

1. Open the Services window.
2. Select **Warehouse logger**.
3. Select the **Startup** button.
4. Click **This Account**.
5. Type the DB2 user ID.
6. Type the DB2 password in the Password field.
7. Type the DB2 password in the Confirm Password field.
8. Click **OK**.
9. Repeat step 1 through step 8 for the Warehouse Server.
10. Stop and then restart the vwserver and vwlogger services.

Workaround: Perform the following procedure for Windows 2000:

1. Open the Services window
2. Select **Warehouse logger → Action → Properties**.
3. Click the **Log On** tab.
4. Click **This account**.
5. Type the DB2 user ID.
6. Type the DB2 password in the Password field.
7. Type the DB2 password in the Confirm Password field.
8. Click **OK**.
9. Repeat step 1 through step 8 for the Warehouse Server.
10. Stop and then restart the vwserver and vwlogger services.

- **Defects 132208 and 132228:** execsql statement does not move DB2 timestamp values correctly.

When the execsql statement `--#INSERT_INTO_SOURCE` is used to move a DB2 timestamp value into an mssql datetime column, a timestamp overflow error occurs.

Workaround: Use the following function to move the timestamp value:

```
substr( char(datetime_column), 1, 23)
```

- **Defect 134025:** The rollup.sh script does not accept path names that contain the space character.

Programmers creating warehouse packs that use the rollup.sh script during data mart ETL processing must manually update the script to enable it to process path names that contain the space character. Otherwise, the following message is generated when the script runs:

```
sql1024n A database connection does not exist.
```

Workaround: Edit the script ($TWH_TOPDIR/tools/bin/rollup.sh) and change all occurrences of the following text:

```
errOut=` $DB2EXEC -sxtd"$delimeter" -z "$tempSqlOutput" -f "$tempSqlScript"`
```

Place a backslash (\, the escape character) in front of each double quotation mark in the line, as follows:

```
errOut=` $DB2EXEC -sxtd"\$delimeter" -z "\$tempSqlOutput" -f "\$tempSqlScript"
```
Chapter 4. Documentation problems

Defect 134589: The sample connection string is incorrect in the Create a Data Mart online help topic.

The description of the database connection string in this help topic should be as follows:

**Database Connection String**

Specifies the universal resource locator (URL) connection string for the data mart. This database connection string is specific to the database driver and can contain up to 50 alphanumeric characters. For example, for DB2, the connection string is `jdbc:db2:database alias`. For example, if your data mart database alias is `TWH_MART`, the database connection string should be `jdbc:db2:twh_mart`. For further information consult the appropriate database documentation. This field is required.
Chapter 5. Internationalization notes

This section provides information about known problems with the non-English language versions of the Tivoli Enterprise Data Warehouse.

Notes:
1. Workarounds are not available for some defects.
2. Some defects described in “Software problems and workarounds” on page 14 might affect translated versions of Tivoli Enterprise Data Warehouse.

The following information is provided:
- Defect number
- Problem description
- Workaround

Internationalization defects

Defect information in this section is categorized as follows:
- Installation or uninstallation
- Report interface
- Miscellaneous

Installation or uninstallation defects

- Defect 129724: DBCS characters on Linux and AIX are unreadable during initial startup of the InstallShield program.
  When the InstallShield program is started on AIX and Linux DBCS machines, an unreadable message is displayed.
  Workaround: Ignore the message. The installation proceeds normally and the installation wizard displays correctly.

- Defect 132155: Initial install messages displayed when running setup_unix.sh are not translated.
  When running the setup_unix.sh program, the following message is not translated and it is displayed in English:
  Copying installer from CD to local drive. This will allow execution from the local drive and free the CD drive to change CDs.
  The copy will take several minutes....
  This message explains that after the copy is complete, the InstallShield program runs in the specified language.
  Workaround: There is no workaround for this problem.

- Defect 132421: The Tivoli Enterprise Data Warehouse Installation window takes a long time to display.
  For a DBCS RedHat 7.1 Linux machine, the Tivoli Enterprise Data Warehouse Installation window takes between 20 and 40 minutes to change.
  Workaround: Maximize the installation wizard window before you click Next to provide sufficient room for the entire DBCS character string to be displayed on a single line.
Report interface defects

- Defect 129052: The report interface does not correctly display DB2 messages when DB2 Server uses a double byte character set (DBCS), but the user’s Web browser and operating system support only SBCS.
  DB2 messages received by the report server are echoed unchanged to the user in IBM Console messages. If you are running Tivoli Enterprise Data Warehouse with DB2 Server in a DBCS language, the DB2 product generates messages containing DBCS characters. These messages cannot be correctly displayed by a SBCS-only Web browser.
  Workaround: Ignore the unreadable text that follows the message identifier. Use the message identifier (for example, DB21002E) to find information about the error in the DB2 message manuals or in the DB2 information that is installed on your system.

- Defect 129115: DBCS characters are corrupted in the graphical chart of reports.
  When using the IBM Console on Microsoft Windows systems in Traditional Chinese, characters might overlap each other and underscore characters might display incorrectly. This is caused by a problem with the font used by the Java run-time environment on Microsoft Windows systems.
  Workaround: Use the following procedure to install the correct fonts:
  1. Unzip font file \ps\fonts\mtsans_t.zip that is shipped on the documentation CD with Tivoli Enterprise Data Warehouse.
  2. Install the font on the affected system:
     - On the task bar, select the Start button → Settings → Control Panel
     - Double click the Fonts folder.
     - From the menu bar in the Fonts window, select File → Install New Font
  3. From the directory into which file mtsans_t.zip was unzipped, select Monotype Sans WT TC (True Type).
  4. Click OK.
  6. Modify file font.properties.zh_TW:
     a. Change to directory ps_install_dir\psjvm\lib, where ps_install_dir is the name of the directory in which Tivoli Presentation Services is installed.
     b. Edit file font.properties.zh_TW.
     c. Change all occurrences of \u7d30\u660e\u9ad4 to Monotype Sans WT TC
     d. Add the following statement to the bottom of the file:
        filename.Monotype_Sans_WT_TC=mtsans_t.ttf
  7. Restart all Tivoli Presentation Services services. See Installing and Configuring Tivoli Enterprise Data Warehouse for more information.

Miscellaneous defects

- Defects 130921 and 131048: The format of the date is incorrect or the date is displayed in the wrong format in some messages and windows.
  There is no workaround for this defect.

- Defect 131141: In some language environments, you might be unable to logon to the Data Warehouse Center and receive an error indicating that a character could not be converted and was replaced with a substitute character.
  Workaround:
1. Set the DB2CODEPAGE system environment variable to the value 1208.
2. Reboot the machine.

**Note:** Setting the DB2CODEPAGE system environment variable affects all local applications that connect to the DB2 databases.